Creating the web page and a template for your site

You are now ready to create your html site, using the layout comp created earlier. We talked about versioning, or creating back-ups of our work as we go. 

Backing up

Before we start with the implementation of the layout, let’s make a back-up of our prototype files. In your My Computer file view for PC or Finder window for Mac, locate your local folder for your Images from Iceland, where you created your prototype. Open this folder and select the Web–Images-Iceland folder and copy. Browse to the Development folder and then the Back-ups. Paste the copy and rename it Web-Images-Iceland-Prototype. 

Back in Dreamweaver, make a copy of the web-images-iceland-template-start and add your initials make sure your site is defined as your folder web-images-iceland-template-startxx found inside Images-Iceland. Open the file index.html page (it is the same as the saved final in the prototype tutorial) and save with a new name, work_page.html. In this tutorial, we will fashion the html and css to match our layout comp and then save this page as a template page upon which to base all our site pages, for uniformity and control. 

From the Fireworks comp, we are going to jot down some measurements and note our color choices so that we can transfer them to the css style sheet. Our overall fixed page width is 740 pixels. The measurement of our text box is 274 pixels. This was the resulting dimension in our comp (remember the guide was at 374 pixels, and we had 80 pixels margin on the left of the page area to show the background color and another 20 pixels padding inside, which leaves 274 for the text box. The photoarea is 405 pixels wide. The content area has 20 pixels of padding. The color for the background is #666666 and the page content background color is #D5D6D5 and the text box background color is #C1C1C1. The photoarea background is white.

Another tool that will help you be faithful to your bitmapped design is to use the Tracing image feature in Dreamweaver. Go to Modify> Page Properties and choose the last in the categories list: Tracing Images. Browse to the Iceland comp png, found in the development folder: Development/Layouts/iceland-comp.png. Set the transparency to 100%. Dreamweaver will prompt you save a copy to your site folder. You can indicate NO.

You now have the faint image of the comp in the background to check your Dreamweaver work against as you create the html and css.

To review our page structure, we have a wrapper containing all the page divs. We have a masthead and a navigation div, followed by a content div, which wraps (contains) the copyarea and photoarea divs. The content div is followed by a footer div.

As we do for all new page layouts, we create a new css rule for the tag body. In the Box category, set both padding and margin, same for all, to 0 to remove the different browser's default page margins. In the Text category, set font-family to Verdana, Arial, Helvetica, sans-serif, and color to #666666. This sets the default font and color for our site. In the category Background, indicate #929194. With your iceland-comp.png as the Tracing Image, you can actually use the color picker to grab this color from the image. 

Page Wrapper

Create a new css rule for the id #wrapper (advanced selector radio button). Type #wrapper in the id text box, make sure it is defined in the iceland.css style sheet and click OK.

In the resulting css dialog box, select the Box category, we want to set the width of our page wrapper to the 740 pixels that we used for the page area in our comp. Set padding to same for all and 0. For margin set top and bottom to 0, and right and left to auto. This will center our page wrapper horizontally. In Background category set color to #d5d6d5 (or use the color picker to grab the color from the tracing image), to create our gray background for the area below our masthead and navigation as in our layout comp.

Masthead

Next we will set styles for the masthead banner and the navigation. Create a new css rule for the id #masthead. In Background category, set the color to #FFF. In the work_page.html, place your insertion cursor in the masthead div. Select and delete any remaining placeholder text. 

To avoiding confusion with the rules that we set previously for all divs to help give our prototype shape, we are going to delete that extra style rule. Find the style rule for div in your css panel all view. Select it and click on the trash icon at the bottom of the css panel.

Then using the image icon on the Insert common panel (or from the toolbar: Insert>Image), browse to your images folder and locate the masthead.jpg that was exported from Fireworks and click choose to place the masthead image inline in the masthead div. In the resulting alt text dialog box, type a description of the photo: Photo of distant glacier on horizon. Create a new css rule for #masthead. In the Background category, set the background-color to #FFF.
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Navigation

Now we are going to add the navigation images. 

Create a new css rule for the #navigation id (advanced Id) In the Box category, for padding uncheck same for all and set right and left to 20px. In the Background category, set background-color to #FFF.

In the design view you should have your unordered list of navigation links. In the navigation div, click after the last letter of news, checking the code view to be sure that you are still inside the <li> and <a> tages, and insert the image nav_news.gif found in your images folder. Add the alt text news. Do not type “link to news”. Simply use the same text as is on the button. The assistive technologies announce the image as a link. If you look at your code, you will see that the image is now inside the <a href> tag for the index.html link. In the code view, delete the original placeholder text news, leaving just the image in the <a href> tag.

Repeat these steps for the remaining 3 navigation images. There will be borders around these images, indicating that they are active links. Don’t worry about this. We will fix this in the css style sheet. Click on one of the navigation images and create a new css rule for #navigation img (Advanced Id)

[image: image2.wmf]
In the Border category, leaving same for all checked, select none for top style. Leave everything else blank and click OK.

Create a new css rule for #navigation ul. In Box category set float to right and set margin and padding to 0 for all.

If you have spaces in the design view between the list images, you need to go to the code view and select and delete any white space between the closing </li> and opening <li> of the next navigation item. Once the code is running together, and you are sure no extra spaces are in between, you can go up to Commands>Apply Source Formatting to restore the code view order. This takes care of the bug that occurs with extra white space and list items.
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Insert the page-title.gif after the unordered list for the navigation. Click anywhere in the nav links and then select the <ul> in the tag selector and using the right arrow key move outside the tag. Check in your code view to make sure the cursor is just outside the closing tag for the </ul>. Insert the image for page-title.gif here. Add the alt text Images from Iceland and click OK. 

Content

Next we will create the content area. As you remember we have a #content div with two nexted divs, #copyarea and #photoarea (which has a caption in a paragraph below the image).

Make sure that your content div placeholder text is deleted. Create a new css rule for #content (Advanced Id). In the Box category, keeping same for all checked, set padding to 20px and margin to 0 and click OK.

Completing the photo column

We already have the rules for these nested divs defined in our css from doing the prototype, so we are simply going to edit these rules. Click on #photoarea in the css all rules panel and at the bottom of the css panel, select the edit or pencil icon. In the Box category, change the width to 405px (don't forget to change the measurement to pixels) and for padding, set top, right and left to 5px and  for bottom set 10px. Float should already be set to right. In the Background category, set background-color to #FFF. In the Block category, set text-align to center. This will center our photos and captions. Click OK. Replace the placeholder photo with default.jpg which will be the default collage image showing when the page opens in the browser. Select the placeholder image and in the Properties panel, click on the folder icon next to the Src text box, to browse to the images folder and select default.jpg.
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Finishing the copy column

Select #copyarea in the css all rules panel and the edit (pencil) icon at the bottom of the panel. In Background category, set the background-color to #C1C1C1 just like we did in our comp. In Box, change width to 274px (be sure to change to pixels). Set padding for top, right and left to 0px and bottom to 9px. In Border category, set style to solid, width to 1px and color to #FFF.

Open the iceland.css file to edit the #copyarea in the code for min-height. Find the css rule for #copyarea and add another line in the code, inside the curly bracket to define the minimum height for the copy area, in case there is a short amount of text:

min-height: 343px;

Don’t forget to close the declaration with the semi-colon.

Completing the footer

Finally we will edit our #footer id. Select #footer in the all rules css panel and click the edit (pencil) icon at the bottom of the panel. In the Box category, make sure that Clear is set to both. This makes sure that the floats on the copyarea and photoarea are cleared and the footer will stack below the content div. Click OK.

Save your work_page.html and iceland.css. files.

Adding and styling the text

Title – section heading

In the copyarea div, we are going to style the text and set the section heading graphic. To make the section heading semantically correct, we will place the image inside a <h1> tag. Select the Home and News Items text and apply heading1 to this (if not already set) using the Format dropdown list in the properties panel. Click after the last letter of the text (check your code view to make sure you are still inside the h1 tag). Insert the title_news.gif and enter news for the alt text. Delete the original text, being careful not to delete the h1 tag. If you preview the results in the browser you will see the space above the image. This is the normal h1 top margin. We will remove this with css. Edit the css rule for h1 and in the Box category, set padding for all to 0 and margin to 0 for top, right and left and bottom to .75em.

To create the copy text, we will make a css selector that is specific to the paragraphs in the #copyarea div. Click in any part of a paragraph in the copy column and create a new css rule for #copyarea p (Advanced selector) and in the Type category, set the font size to .8em and the line-height to 1.1 multiples. In Box category, set the padding for top and bottom to 0 and right and left to 7px. Set margin for everything but bottom to 0 and set bottom to 1em.

In the css panel, all view, select and edit the css rule for h2. In the Text category, set font to Arial, Helvetica, san serif, font size to .8em and case to uppercase. In the Box category, set padding to 7px for right and left and 0 for top and bottom. Set margins to 0 except for bottom which is set to .75em.

Your layout should closely resemble the image created in Fireworks as seen below: 
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Building the footer

In order to make it easier for viewers with small monitors to navigate without having to always scroll back up to the top, designers often add navigation to the footer and include a link to take the viewer back to the top. This is done in text, rather than images. We already have our unordered list, and have li css set to display inline and the footer is stacked below the content.

Now we want to move the text links in the footer to the right. Click in the unordered list and select the <ul> tag in the tag selector bar. Create a new css for #footer ul as Advanced selector. In the Block category, set text-align to right and in the Box category, set padding to 20px same for all and margin to 0, same for all.

Styling the footer links

Create a new css rule for links in the footer, #footer a for the characteristics that are the same for all states. In the text category set size to .7em and set weight to bold. Create a new css selector rule for the link states, in order (a:link, a:visited, a:hover, a:active). Create a new css rule for #footer a:link as an Advanced pseudo-class. In the Text category, set color to #444444 and weight to bold and decoration none (removes the underline). Repeat creating new css rules for each state #footer a:visited (with color slightly lighter at #666666 and no underline), #footer a:hover (text slightly darker and underlined: #333333 and decoration and underlined) and finally #footer a:active (color blue from glaciers #336699 and underlined). Save All.

Preview the page in the browser. You should see the footer navigation state changes as you hover, click on a link and visit another page.
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At this point you should have a web page resembling the original mockup, using semantic html and styled with css for layout and typography. 

Saving as a template

Now we are ready to turn this working page into a Dreamweaver template. We will use the template to control and help manage our pages for the site. We no longer need the tracing image, so we will remove this. Go to Modify>Page Properties>Tracing Image and delete the reference to the iceland-comp.png.

A document that is created from a template remains connected to that template. A template has regions in that are editable in documents based on that template. The other areas cannot be edited on a page created from the template, but are changed by editing the template itself. When an edited template is saved it updates all the pages created from that template. You can modify a template and immediately update the design in all documents based on it. This takes place in your the local site, not on the remote server. Once the pages have been updated locally, they must be uploaded to the server to replace the server pages. We will learn:

· Creating a template

· Working with editable regions

· Creating pages based on templates

· Embedded templates

Save the current work_page.html as a template On the Toolbar select Save as Template
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Make sure you are saving to your Iceland-template site. Give your template a name that will be meaningful. Call this one iceland-basic. Dreamweaver will ask if you want to update links, click yes. Dreamweaver will automatically create a folder at the site root called Templates and save the new template document with the extension .dwt. 
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Now we need to decide what areas of our template need to be editable on individual pages and what should be controlled for all pages with the template.

The masthead, navigation and footer areas will be the same regardless of the page. So this should be controlled by the template. 

Dreamweaver also automatically creates editable regions in the head for the page title and to add editable meta tags for unique keywords and description. Go ahead and put some basic keyword and description information into the meta tags so this will be included for each new page and then can be fine tuned as needed for individual page content.

Keywords:

Keywords are used to provide help to search engines. They should include any names or phrases that your think your visitors might be using to find your content. 

iceland, photography, geysir, gullfoss, thingvellir, waterfall, photo, craig grannell, images, landscapes

Description:

The Description meta information is often used by the search engines and displayed as the short description in the results. Not all search engines use your meta description.

Images from Iceland - photographs from the land of fire and ice.

All the other editable areas will be in the div #content.

· copyarea

· photoarea

· individual photos and captions

While we could make the entire copyarea editable, to keep consistency of the copy area, we can make specific parts ediable. We will make the page title image editable.

In the iceland-basic.dwt template select the image news in the copyarea. Check in code view that just the image itself and not the h1 tag is selected. Right click on the image and from the contextual menu select Templates>New Editable Region
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In the resulting dialog box type a name for the region. Do not use spaces, underlines or hyphens. Name this editable region pageheading.
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Click OK and you will see a turquoise box and label surrounding the image to indicate that this element is editable.
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Next select the remaining copy and create another editable region and name it pagecopy.

Next select the photoimage and the caption paragraph and create another editable region and name it photo.

Save you the iceland-basic.dwt template. You will receive a warning dialog box. We want to have only the image editable and it will always be inside the block tag <h1> so this is OK.

[image: image12.wmf]
Creating the site pages from the template

We are now ready to create our site pages using the template. From the Toolbar, select File>New. In the dialog box, click on the Templates tab and select the Site “web-iceland-images” and the iceland-basic template we just created. You will see a thumbnail of the layout in the Preview, and make sure that in the lower right the Update page when template changes is checked. Click Create.
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An untitled and unnamed document will open in Dreamweaver that is just like the template, however it is now a regular html document with the editable named areas labeled and surrounded in turquoise outline.

The home page

Save this file as index.html replacing the original prototype file. On the index.html page, make sure that the <title> is proper. The <title> area is always automatically editable in a Dreamweaver template. In the Development folder on the desktop, open the Copy folder and then the index.txt for the home page copy. Add the copy to the editable pagecopy region. Change the dated news sub-titles to heading level 2.

About page

Create a new page for the about page, from the template. New>html select the template tab and then site web-iceland-images and Iceland-basic. Edit the <title> to Images from Iceland - about and make any changes needed to the meta keywords and description for the about page. Copy the text from the Developer/Copy about.txt file and change crossheads to  heading level 2. Click on the page heading image gif and in the Properties panel browse to replace it with the title_about.gif. Be sure to change the alt text to about
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Change the image in the photoarea by double clicking it and choosing the about.jpg in the images folder. Change the alt text to images of iceland and photographer. Edit the caption text More images from Iceland

View more images in the gallery and select the word gallery and link to gallery.html.

Gallery page

The gallery page will contain an introductory paragraph and a number of thumbnails, which will be previews of gallery images. Clicking the thumbnails will enable a user to see the full-size image and its accompanying caption. The images are all take from digital photos and have been resized to 400 x 300 pixels. The thumbnails are the same image shrunk to 44 x 33 pixels.

Create a new page from the template and save and replace as gallery.html. Change the <title> to Images from Iceland – gallery. Double click on the page heading image to replace with the title_gallery.gif and change the alt text to gallery. Copy the text from the Development/Copy folder file gallery.txt. Change the sub-heading text to heading2. 

Insert the thumbnails for each section. Enter the introductory copy in the pagecopy editable area and then add the thumbnails. These should be organized into groups of five, and each group should have a heading formatted as heading2. Ultimately each thumbnail will be linked and have a JavaScript behavior that will replace the large image with the corresponding image for the thumbnail. Be sure to use a descriptive alt text attribute that describes each image. This should at least be the caption and will provide the only alternate content, since the large image and caption are provided with JavaScript and may not be available to assistive technologies. For now they can all just be linked to gallery.html. Use the link properties panel to add the link to each thumbnail. Make sure that the images do not have any paragraph formatting.
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The spacing is currently a problem. We will use a contextual selector for #copyarea img to only affect this area’s images. Create a new css rule for #copyarea img and in the Box category set the top and right margin to 0 pixels, the bottom to 10 and left to 7. In the Border category set the style to solid, width to 1px and color to #929194. 
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This syle also affected the page heading graphic, so we will fix this with a new css rule for #copyarea h1 img and set the Border category to style none and width to 0, same for all. In the Box category, set margins to 0, same for all.

The result; the thumbnails are now correctly placed and the page title is not misplaced.

Change the main photo and caption to the image associated with the first thumbnail image, glaciers_1.jpg with caption Distant glaciers.
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We will return to make each thumbnail change the large photo with a bit of JavaScript. But first lets create our contact page.

Contact page

The final page will enable visitors to contact us. What you include here depencs on the nature of your site. If it is business oriented, be sure that you provide as many means of contact as possible. Supplying only an email address can be frustrating and you want your visitors to know that your business has a physical location and business phone.

Create a new page from the template and save to replace the prototype contact.html. Change the <title> to Images from Iceland – contact. Change the page title graphic by double clicking and replacing with title_contact.gif and change the alt text to contact. Find and open the copy in the Development/Copy folder for contact.txt. copy to the copyarea. Change the sub-title crossheads to heading2. for the email address, select the relevant text, CNTRL + C to copy to clipboard. In the Properties Panel, link text box, type mailto: and immediately after with no space, paste the email address.

We will build the contact form in the photoarea. Delete the image.Insert another div inside the photarea div. Delete caption paragraph and the text. With your insertion point in the editable area and add a div, at insertion point and name it formarea. Create a new css rule for #formarea and in Block category set text-align to left and Box category for padding left to 20px. Delete the div formarea placeholder text and any paragraph tag that might be remaining (check code view).

Add html form code

Change the Insert Panel from Common to Forms
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With your cursor inside the formarea div, click on the Insert Form Tag icon

[image: image19.png]Dreamweaver File Edit View Insert Modify Text Commands Site

Forms s G B0

®06 * contact.html (XHTML)*
@ iceland.css | © iceland-basic.dwt | © index.ntmi* | © abouthtml | @ gallery.html | @ contacthtmi® |





In the Properties panel type mailform as the name of your form and choose application/x-www-form-urlencoded as the Enctype (encoding type).
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Keeping your cursor inside the Form tag, add a Text Field. In the resulting dialog box, Type Name as the label name and make sure that attach label tag using “for” attribute is checked and Before form item is also check. Click OK and while the form field is still selected, in the Properties Panel, change Format to Paragraph.

[image: image21.wmf]
Hit Enter or Return once and using the Insert Form Panel, insert one more text field and for label type Email.
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Hit Enter or Return once more and from the Insert Form Panel, select the Insert Text Area icon and for the label type Comments. Set the line number to 5.
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Click on each input field and make sure that the TextField or TextArea  name is the same as the label (name, email, comments), but without any capitalization.  Dreamweaver does not fix the label at the same time, so we must do this in the code or quick editor. Click in the label tag, and using the tag selector panel, right click and selecting Quick Tag, edit the label tag to change the for attribute to match the TextField or TextArea name.
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After changing the attribute for, while the label tag is still selected, click your right arrow key once to move off the label tag and then add a soft return, or SHIFT + ENTER or SHIFT RETURN. The labels will now be above the form fields making a nice readable layout. Do this for each of the three form fields.

While these steps are a bit tedious with this version Dreamweaver, it is important for the proper function of the form and to make the form accessible to assistive technology.

Submit button
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Use the button icon to create the submit button. In the dialog box, type Click to Submit as the label.

Select Submit button and then select the <p> tag surrounding it. Move off the paragraph by pressing the right cursor key once. Using the Hidden Field icon, found between the TextField and TextArea icons, insert three hidden fields
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recipient – the email address that the form will be sent for example parees@pasadena.edu
subject – the subject line you want in the email – type Images from Iceland inqury

redirect – the page you want the viewer to see after submitting the form. Contact-thanks.html

The form is complete, but could benefit from some styling.

Add a new css rule as a custom class for .formfield. In the Border category set style solid, width 1px and color #929194. In the Box category set width to 300px and padding, same for all, to 2px.

Add the class in the contact.html page for the 3 fields, by clicking in each and using the tag selector, right click and from the dropdown menu select Set class and select formfield.

Create a new css  as a custom class for .formfieldsubmit and in the Box category set a width of 80px and paddng 3px for top and bottom and 7px for right and left. In the Border category, set style to solid, width to 2px and color to #929194. Add the style to the input#submit.

Create the redirect page as contact-thanks.html

Change the <title> to Images from Iceland – contact and replace the page title image with contact.gif. Replace the text with copy found in Development/Copy for thanks. Use any image or the default image for the photoarea and provide a caption.

The spacing and border are not quite right, but that will be fixed with the css. Create a new style rule for #copyarea img as an advanced selector. In the Box category, set top and right margin to 0, bottom to 10px and left to 7px. In the Border category set style to solid, width to 1px and color to #929194.

Insert Text Field





Insert Text Area
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